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Basic Functions 

• Opening models 
• User interface 
• Plotting modes 
• Animating 
• DATA menu for contouring 
• Max & min on plots 
• Data Components 

– 2D/3D 
– Beam 
– Contact 
– Principal 
– Other “LSDA” 

• Other methods of extracting data 
• Quick-pick 
• Picking 

LS-DYNA is a registered trademark of Livermore 
Software Technology Corporation 

• Part Tree 
• Measure 
• Display entities 
• Labelling 
• Cut sections 
• Volume Clipping 
• Deform 
• Display Options 
• Multiple Models 
• Image & movie output 
• Shortcuts 
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Advanced Options 

• Attached 
• Groups 
• Contour options 
• Tuning Graphics Performance 
• Opening models (advanced options) 
• Control of settings & properties 
• Overlay & comparison of models 
• Reflecting Models 
• Faster animation 
• D3PLOT – T/HIS link 
• ALE Data Components 
• Trace node 
• XY Data 
• External data – “blob plots” 
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 • Compressed (Cut-Down) PTF files 
• New d3plot file format 
• Background image 
• Background animation  
• User-defined data 
• D3PLOT scripting 
• Pages 
• Menu Attributes 
• Preferences 
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Opening Models 

• The default “Open Model” menu allows a single model to be selected by 
either typing in a filename or browsing for a file. 

• Multiple models can also be opened – see advanced section. 

For LSTC filenames 
(d3plot etc), use the 
File filter to select d3*. 

 

 

 

If there are large gaps 
in the file family, (e.g. 
d3plot, d3plot01, 
d3plot02, d3plot15), 
increase “File Skip” 
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Opening Models 

• In addition to reading the 
PTF/d3plot file, a number of 
additional files can also be 
selected:  

Settings File Contains D3PLOT program settings for each model / window 

Properties File Contains model data; colours, blanking, transparency etc 

Ascii groups Group information 

Add’l data (.ztf) Contains additional data used by D3PLOT to plot items not in the 
PTF/d3plot file (created by PRIMER).  

Contact data (.ctf) Contains information on contact surface location and forces 

Spring / mass (.xtf) Contains information on springs, lumped masses, joints 

Spotweld, SPC (LSDA) Contains data for spotwelds, SPCs, seatbelts, X-sections.  
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User Interface – D3PLOT 10.1 
Quick-Pick Control 

Controls the mouse action when 
applied within the graphics area. 

Dialogue & List area 

Area for command-line 
input and output, also 
acts a listing area for 

messages. 

Graphics Area 

Area within which 
graphics are drawn. 

Menu tabs 

These control which option is 
displayed in the current menu 

panel. Model and Part Tree will 
always be available in addition 

to selected options. 

Current menu panel 

"Current Menu Panel" Displays 
the menu for the option 

currently selected by the menu 
tabs. 

Tools 

Provides access to D3PLOT 
specific functions. 

Top menus 

Allows access to basic options, keywords 
and tools, in a drop-down menu format. 

Provides all aspects of view control: direction, perspective, 
scale, etc. Contains the drawing commands and their settings. 

Viewing & Drawing Commands 

Animation Controls 

Controls states and what is 
displayed during animation 
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User interface – Dynamic viewing 

Dynamic viewing:  

SHIFT+Left   Mouse button = Rotate 

SHIFT+Middle Mouse button = Pan 

SHIFT+Right  Mouse button = Zoom 

For Rotation use <Left mouse> in the above combinations.  

For Translation use <Mid mouse> in the above combinations. 

For Scaling use <Right mouse> in the above combinations.  
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Plotting modes – LI, HI and SH 

LI HI SH 

Note: In 
combination 
with SH, also 
use shortcut 
key ‘y’ to 
show mesh. 

LI 
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Plotting modes – CT and SI 

CT plot – no lighting, user-
defined contour levels   

“Solid” SI plot – lighting, 
sharp contour areas, auto or 
user-defined contour levels   
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Plotting modes – Contour Plots 

ISO 
Node Cloud 

(CL) 

CT SI 

ISO surfaces and Node 
Cloud (CL) allow better 
display of results inside 
blocks of solid elements 

ISO – shows surfaces of 
constant data value, 

within a solid element 
mesh   
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Plotting modes - ISO 

ISO plot is especially useful 
for fluid/structure models. In 
this example the display 
mode of the skull is set to 
SHADED, while the ISO 
surfaces are displayed for 
the fluid mesh that fills and 
surrounds the skull.   
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Plotting modes – Cloud Plot (CL) 

CL- Cloud plot – shows a 
dot at the centre of each 
solid element, coloured 

by data value   
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• Velocity/Vector plot offers a choice of displacement, velocity or 
acceleration arrow-plots. 

Plotting modes – Vector 
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… or animations can be controlled for individual windows using the controls in 
each window: 

Animating 

• All windows can be animated using the controls in the bottom right corner: 

Play 

Next frame Pause 

Previous frame 

First frame 

State number 

Last frame 
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Animating 

• Plot state numbers can be entered to skip to a certain state: 
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The DATA menu for contouring 

• The DATA menu 
controls the contents 
of result plots: which 
data component is 
contoured, contour 
levels, etc. 

• Press CT or SI (or 
shortcut F) to create 
a contour/fringe plot 

Bring the DATA menu 
to the front  

The Component 
button invokes this 
menu, allowing the 

data component to be 
selected from drop-

down menus  
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Other controls – 
averaging switches, 

shell surface 
selection, etc  

Contour level control 

Controls for other types 
of plotting – beam plots 

(bending moment 
diagrams etc); principal 

stress vector plots; 
contact pressure plots 

Other options under 
here include Limiting 

Values, to display only 
entities whose data 

value is within a given  
range 

The DATA menu for contouring 
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The DATA menu for contouring 
Control settings: Auto option 

– 6 levels 
Control settings: Max + Min –  
enter the max and min values 

Control settings: Auto option 
– 13 levels 

Control settings: User def – enter 
all the levels manually 
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Contour Bar Number Format 

• By default D3Plot will try to work out a sensible number format to display the 
contour bar numbers.  However, the number format can be controlled 
manually. 
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Turn off display of 
max/min 

Max and min on plots 

• Nodes or elements have the maximum and minimum 
values annotated on plots – this can be controlled or 
turned off. 
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Data Components – 2D/3D 

• Shells - example of plotting von Mises stress, steps 1-5:  

1 

2 

3 

By default the results for the Middle integration point of a shell is shown; 
however, this can be changed, based on what was made available via 
MAXINT in *DATABASE_EXTENT_BINARY – for example “Layer 1”,Layer 
2”,…, for each integration point, or “Max all” value can be read. 

4 
5 
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Data Components – 2D/3D 

Airbag Particles 
• Airbag Particle data from PTF / d3plot files is fully supported 
• Airbag Particles can be included in vector plots 
• Special data components just for Airbag Particles are 

available in normal contouring modes 

Back to Contents 
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Data Components – 2D/3D 

SPH Elements 
• SPH Elements are fully supported 
• SPH data components may be plotted, written and graphed 

as XY data 

Back to Contents 
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Data Components – 2D/3D 
• Material properties of parts can be contour plotted, used in user-defined 

components and written out from the WRITE menu. 
• These come from the ZTF file created by Primer. 

An example of its use could be to create a 
user defined component to plot stress / yield: 
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Data Components – 2D/3D 

Airbag Particles / SPH Elements 
• The symbol type and size of Airbag Particles and SPH Elements can be 

controlled in Display options 

• The visual properties can be altered 
in the same way as other elements 

Back to Contents 
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Data Components – Beam 

Plotting Beams 
• Beam elements cannot be contoured in the same way as 2D 

and 3D elements, since they have no visual area on which 
to plot results. Therefore the special "Beam" plotting data 
display mode must be used to visualise results from beams. 

• All beam types have the BASIC set of data components: 3 
forces + 3 moments. 

• Belytschko-Schwer beams using a resultant plastic 
formulation will have "extra" PLASTIC components. 

• Hughes-Liu (integrated) beams can optionally write "extra“ 
STRESS (and strain) values at integration points. 

• D3PLOT supports both basic and "extra" data components 
for all these beam types. 
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Data Components – Beam 

Plotting Beams 
• D3PLOT can plot the actual beam thickness, if a .ZTF file is output from PRIMER 

and available in the run folder; the thickness can be changed from “Attributes”. If no 
.ZTF file has been read, a square section of the "Thickness" given below will be 
used. 



LS-DYNA ENVIRONMENT 

[back to contents] 

Data Components – Beam 

Plotting Beams 
• There are two data plotting modes for the display of beam results: 

• DP (DIAGRAM_PLOT) This produces a "diagram" plot showing results hatched on the 
beam. Hatching size is proportional to data magnitude, and colour also follows the normal 
contour band limits. Directional data is displayed by default on the relevant local beam axis. 
Any data component can be displayed this way, not just bending moments. 

1 

2 3 
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Data Components – Beam 

Plotting Beams 
 

• CT (CONTINUOUS_TONE) The continuous-tone plot shows exactly the same results as in 
the diagram plot, but the results are drawn as thick blocks of colour on the beam centreline. 
This can give less cluttered plots, but no visual indication of the data or beam orientation is 
possible. 

1 

2 3 
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Data Components – Contact 

• In order to be able to plot the 
contact area, a .CTF file 
needs to be requested when 
the analysis is submitted, 
please see the LS-DYNA 
manual for details.  

• If a CTF is found and read 
when the model is loaded in 
D3PLOT, then the Contact 
plotting menu will become 
active. 
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Data Components – Contact 

• Visualizing contact area in D3PLOT: Data -> Contact -> A warning will appear as the 
contacts are not visible by default:  

• To make the contacts visible, switch them on in Display -> Entity 
(shortcut ‘e’) -> Contact 
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Data Components – Contact 

• Visualizing contact area in D3PLOT: Data -> Contact -> Geometric: CA_CONTACT_AREA  
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Data Components – Contact 

• Visualizing contact stress in D3PLOT: Data -> Contact -> : CN_CONTACT_NORMAL  
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• The panel “Principal” controls the plotting of 
Principal stress and strain vector plots. 

• These vectors can only be displayed on 2D and 3D 
elements (solids and shells), so if you have none of 
these in your model, it will be unavailable. 

• STRESS and STRAIN categories are only made 
available if their respective tensors are present in 
the database file. 
 

Data Components – Principal stress/strain 

1 

3 

4 
5 

2 
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Data Components – Principal stress/strain 

• By default the arrow length 
is proportional to stress. 

• Alternatively the arrow 
length can be fixed. 
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The ZTF file created by PRIMER  
includes data for SPC’s,  spotwelds, 
*DATABASE_CROSS_SECTIONS. 
Results for spotwelds, SPC’s, 
springs and 1D seatbelt elements 
can be read from the LSDA (binout) 
file and displayed. 

Data Components – Other (LSDA) 

D3PLOT 

PTF (d3plot) File 
Nodes 
Solids 
Beams 
Shells 

Thick Shells 
SPH 

Airbag Particles 

ZTF File  
Springs 

Seat belts 
Joints 

Lumped Masses 
Rigidwalls 
Spotwelds 

SPC’s 

Geometry Only 

Geometry + 
Results 

LSDA File 
Spotwelds 

SPC’s 
Springs 

Seatbelts 

Results 

1D seatbelt element forces 
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Data Components – Other (LSDA) 

• LSDA (binout) data components are available 
under the ‘OTHER’  button in the ‘DATA’ 
menu. 

– Because the LSDA file can be large, it is read in a 
separate thread when the model is opened.  The 
‘OTHER’ button will be greyed out until this has been 
read.  All other operations in D3Plot will still be 
available. 

• Each type of data has its own sub-menu, 
listing the available data components.  

• When reading a model, the user can choose 
to read the binout file or not. 
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Data Components – Other (LSDA) 
SPC Forces 
• Force and moment reactions on restraints (SPC forces) can be plotted (requires 

*DATABASE_SPCFORC in the keyword file)  
• All the force and moment components can be plotted as coloured squares 
• The “magnitude” components can also be plotted as vectors 
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Data Components – Other (LSDA) 
Spring Data 
• The following Spring data components are available (requires 

*DATABASE_DEFORC in the keyword file): 
– Spring Force 
– Spring Elongation 
– Spring Moment 
– Spring Rotation 
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Data Components – Other (LSDA) 
Seatbelt Data 
• The following Seatbelt data components are available (requires 

*DATABASE_SBTOUT In the keyword file): 
– Seatbelt Force 
– Seatbelt Length 
– Slip Ring Pull Through 
– Retractor Force 
– Retractor Pull Out 
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Data Components – Other (LSDA) 

Spotweld Data 
• The following spotweld data components are available (requires *DATABASE_SWFORC 

in the keyword file): 
– Spotweld Force (axial) 
– Spotweld Shear (resultant shear) 
– Spotweld Failure (force state relative to failure surface, =1.0 at failure) 
– Spotweld Failure Time (time at which failure occurred) 
– Spotweld Torsion 



LS-DYNA ENVIRONMENT 

[back to contents] 

Data Components – Other (LSDA) 

Spotweld Drawing Style 
• Spotweld elements can be drawn as spheres, so that they are 

not obscured by the panels. 
• Options for setting the size and style are in Display Options => 

Spotweld symbols. 
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Data Components – Other (LSDA) 

Spotweld Drawing Style 
• The drawing style also applies to data plots. 
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Data Components – Other (LSDA) 

Spotweld Failure Time 
• When spotweld failure time is present 

in the binout file, D3PLOT scans 
through all the time-states in the 
binout file to find the failure time of 
each spotweld. These failure times will 
still be contoured even if D3PLOT is 
set to a time-state before the failure 
occurred. 

• In the image opposite, D3PLOT is 
displaying time=zero and showing a 
spotweld that failed at 13ms.   
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Data Components – Other (LSDA) 

*DATABASE_CROSS_SECTION data 
• *DATABASE_CROSS_SECTION definitions can be displayed in D3PLOT (requires a 

ZTF file generated by Primer). 
 

Names and Labels can be 
switched on from the Entity 
panel 
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Data Components – Other (LSDA) 

DATABASE_CROSS_SECTION data  
• Cross Section Area, Force and Moments can be contoured. 
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Data Components – Other (LSDA) 

DATABASE_CROSS_SECTION data  
• Vector plots of Forces and Moments can also be generated. 
 



LS-DYNA ENVIRONMENT 

[back to contents] 

Other methods of extracting data 

• “XY Data” turns information from the d3plot file into 
curves that can be displayed in D3PLOT and exported 
to T/HIS. 

– Data-vs-time – select the entities and data component; 
one curve per entity 

• Data listing (screen or text file) from “Write” menu 
1 

2 
4 

3 

5 
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Other methods of extracting data 

• Data listing (to screen or text file) from “Write” menu. 
• The Entity option allows output of standard element 

and nodal data, eg. element stress, nodal acceleration, 
etc. The example below outputs x-stress for solids: 

1 

2 

3 

4 Select solids 

5 

6 



LS-DYNA ENVIRONMENT 

[back to contents] 

Other methods of extracting data 

• Data listing (screen or text file) from “Write” menu. 
• With this option, the coordinates of nodes at a 

particular plot state can be output to a .key file, 
together with initial stress, as an example. 

• Can also output data values, for example X-displ for 
nodes. 

1 

2 4 

5 

3 

7 

6 
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Quick pick 

Quick-pick control: Used for 
blanking, colour, transparency, 
plotting mode, etc. 
• When D3PLOT is first loaded, this 
is automatically set to Blank – Part, 
so left click will blank parts. 
• The first option shows the 
operation to be undertaken, and the 
second option shows the type of 
item it will apply to. 
• The “Key in” option allows typing in 
entities ID’s.  
• Middle-click reverses the last 
quick-pick action 
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Quick-pick 

• For example, select Only, Include and click on the dummy in this example 
will only show the dummy include. 

1 2 
3 – left 
click on 
dummy 
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Quick-pick 

• For example, select Find, Shells and type in a shell ID that you want to 
locate – D3PLOT will display a cross-hair at that location. 

1 

2 3 – type in 
shell ID 

4 – cross-hair 
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Quick-pick: Information 

• Quick-Pick option Information 
gives details about Parts or 
other entities: Part ID, Part title, 
thickness, material type, 
density, Young's Modulus, etc. 

• Material data and material type 
are not included in LS-DYNA’s 
output files, but are passed to 
D3PLOT by the ztf file that can 
be written by Primer.  
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Quick-pick: Predictive Picking 

• D3Plot highlights and labels the entity that will be selected if the user clicks 
the mouse. This is called “predictive picking”. 

• Predictive picking may be toggled on/off using the ‘P’ button, or using new 
keyboard shortcut P. 

+ 
mouse 
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Quick-pick: Predictive Picking 

+ 
mouse • The same Predictive Picking sketch/label 

occurs when the user hovers over an entity in 
an Selection Menu 
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Quick-pick: Predictive Picking 

• When a screen-pick is ambiguous, D3Plot highlights the closest entity 
(default selection) in blue. Hovering over an entity in the ambiguous menu 
causes that entity to be sketched. 

+ 

mouse 
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Picking Items 

When a menu that requires picking is 
invoked, D3PLOT automatically sets the 

appropriate picking mode – select 
entities by picking on the screen or 

dragging across an area. 

Quick-pick control box changes to tell 
you that picking is active  

Picking items by Polygon 
can be selected 
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Annotation of Picked Entities 

• In menus where items are picked interactively 
the entities are automatically labelled as they 
are picked. 
 
 

• This behaviour can be turned off in the new Pick & 
Select Options menu and set via a preference option.  
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Measure 

• The distance between nodes can be done using the 
measure panel (shortcut ‘m’): 

 

Delete or 
Modify the 

current 
Measure 

1 

2 

Pick 2 nodes 

3 
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Measure 

• Up to 100 “measures” may be defined. Each time the 
user clicks on another pair of nodes, a new “measure” is 
created. 

• The panel shows the status of the “current” measure, 
which is drawn in a thick black line. 

 Controls which 
Measure is 

“current” 

Delete or 
Modify the 

current 
Measure 
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Measure 

Formatting 
options 

• Various formatting options are available, e.g. line colour, 
and whether or not to add node labels. 
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Measure 

Formatting 
options 

• The “measure”s remain visible until deleted.  
• The measurement data (distance) is updated 

automatically when a different time-state is loaded. 
• To remove all the “measure”s from the screen, press 

Delete All in the Measure menu, or press the Delete key 
on the keyboard. 
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Measure 

• The measurements can be exported as time-histories to 
T/HIS via XY_DATA. 

• Separate curves are written for difference in X, Y, and Z-
coordinates, and distance magnitude: 4 curves for each 
pair of nodes. 
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Displaying entities  

• To control what entities are displayed, select “Display”->”Entities” and in the 
panel that opens tick on/off entities – by default all elements are displayed 
(except mass elements):  
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Displaying entities  

• For example, here only the solid elements are displayed:  
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• STATIC labels (labels drawn on all visible entities of the selected type) are 
now switched on/off in the ENTITY panel (shortcut E) 

Labelling 
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Labelling 

• In addition to displaying entity labels, 
any names defined in the keyword file 
for the following can also be displayed 
using information in the ZTF file 
created by PRIMER. 

Parts 
Nodes(*DATABASE_HISTORY_NODE_ID) 
Elements (*DATABASE_HISTORY…_ID) 
Joints (*CONSTRAINED_JOINT_ID) 
RigidWalls (*RIGIDWALL_..._ID) 
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Labelling 

• If node or element labels are 
switched on, drawing the 
whole model becomes very 
slow and the labels obscure 
the model. 

 
• The maximum number of 

labels drawn can be controlled. 
A limiting number can be set 
either interactively or via a 
preference.  
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Labelling 

• DYNAMIC labels (labels drawn on 
screen-picked items) are activated via 
Quick-Pick 

• Use key-in box in Quick-pick control to 
identify an entity by label in the 
graphics window 

 
• Use key-in box in Quick-pick 

control to identify an entity by 
label in the graphics window 
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Labelling 

• Use drop-down to control what 
information is written when 
labelling 

• Labels now stay drawn during 
animation and re-drawing, until 
the Clear Labels button is 
clicked (or the Del key is 
pressed). 



LS-DYNA ENVIRONMENT 

[back to contents] 

Part Tree 

• Part Tree is available as in Primer – used 
for blanking and modifying properties of 
parts. 

• INCLUDE file and/or Assembly structure is 
not in LS-DYNA’s output files, but can be 
made available to D3PLOT using the ztf 
file written by Primer. This happens 
automatically in batch mode when 
submitting LS-DYNA through the Oasys 
shell. If submitting LS-DYNA by another 
means, you can create a ztf file  
– Either run Primer, 

Model=>Utilities=>Write ZTF 
– Or modify your LS-DYNA submission 

script to include ZTF file generation 
automatically – Oasys or your local 
Oasys distributor can advise. 
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Shortcut X or Cut Sect button 
to bring up the menu – or select 

“Cut Sect”. 

Shortcut N (or press Pick 
Visible), then pick a node…   

Cut Sections 
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Now adjust settings e.g. 
change to Constant Y…   

Cut Sections 
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… drawing style either side 
of the plane…   

Cut Sections 
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Cut Sections 
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At any time, press D then use mouse to 
drag section through the model: 

Left mouse = translate 

Middle & right mouse: rotate 

Can also choose a new point with 
shortcut N then pick a node.   

Cut Sections 
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Instant output of section forces. The forces change as 
you drag the section through the model.  

If the model contains beam elements, this feature is 
unavailable until you first press Forces and tell D3PLOT 
what type of beams are present – the beam forces will 
contribute to the section force, and different types of 
beam use different sign conventions for shear force in 
the output files.    

Cut Sections 
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Cut Sections 
• The dragging of cut sections through big models while 

displaying contours can be speeded up using the 
“Options & Tuning” panel.  

Available options include : 
• Update auto contour bands 
• Update max and min values 
• Draw the contours on the cut 

face 
• Draw the cut face 

 
 

• The settings can be saved as  
preferences in the oa_pref file. 
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Cut Sections 

• Cut section forces and moments can be written 
to a csv file: 

M1/W1: Cut-plane force and moment output at time,  4.99950E+00 
 
    PART,    Fx,         Fy,         Fz,         Mxx,        Myy,        Mzz 
     800, -7.9010E-03,  3.1136E-02,  1.7722E-01,  1.2989E+02, -1.8429E-01,  4.1719E+00, 
     801, -5.3758E-03,  2.7748E-03,  3.2521E-02,  1.7323E+01,  6.3289E+00,  3.9410E+00, 
     802,  3.5208E-02,  1.6776E-02, -2.7701E-02, -4.2919E+00, -1.0906E+01, -8.0308E+00, 
     804, -1.7741E-04,  3.1860E-05, -9.0481E-05,  1.1861E-03, -3.1389E-02, -2.5036E-02, 
     810,  1.0578E-02, -3.9736E-04, -7.6691E-02, -5.7626E+01,  1.5117E+01, -8.0408E+00, 
      .        .            .            .            .            .            . 
      .        .            .            .            .            .            . 
      .        .            .            .            .            .            . 
 2000242, -1.3652E-03, -4.4917E-03, -2.3154E-03, -3.0806E-01,  1.6120E-02, -1.7210E+00, 
 2000246,  1.2085E-02,  6.4670E-03,  2.2472E-02,  1.1535E+01, -1.6359E+01, -1.5320E+00, 
 2000252,  9.4278E-03,  3.5153E-04,  3.5429E-03,  7.1106E-01, -3.5469E+00, -1.6143E+00, 
 2000265,  8.7467E-04, -9.9446E-04,  2.0211E-03,  6.4750E-01, -1.3898E+00, -8.4476E-01, 
 2000266, -2.9885E-03, -4.8606E-04,  3.7147E-03,  4.9111E-01, -3.1330E+00, -6.8825E-02, 
   Total, -8.0324E-01,  1.0326E-01, -7.9019E-01, -2.3442E+02,  5.9231E+02,  3.1704E+02, 
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Volume Clipping 
• The Volume Clipping displays just the entities 

within the specified volume. 
• Volumes can be resized by clicking on handles 

and dragging 
 
 
 
 
 
 
 

• They can be repositioned by clicking in the 
graphics screen: 

– Translate in the X direction – left button 
– Translate in the Y direction – middle button 
– Translate in the Z direction – right button 
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Volume Clipping 

• Volumes can be saved and retrieved in a <volume.clip> file containing the 
type of volume, orientation and dimensions 
 

Store 
current 
volume 

Get 
saved 

volume 
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Deform functions 

• The Deform menu has the following functions: 
– Explode - Artificially separates parts by applying 

"explosion" vectors to them. 
– Magnify - Allows scales other than 1.0 to be applied 

to graphical displacements. 
– Fix node - Subtracts the displacement at a node from 

that at all others, effectively "fixing“ it in model space. 
– Shift def - Fixes three nodes, forming a local 

coordinate system, against which all displacements 
are drawn (see next slides for details). 

– Ref node - Makes results relative to those at one or 
three nodes (see next slides for details). 

– Ref state - Makes results relative to a "reference" 
state in this or another model. 

– Transform - Apply translation, reflection, rotation and 
scale to a model as it is read in. 
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• When using Shift-Deformed reference system, D3PLOT can contour and 
output displacements relative to the local coordinate system (using 
Deform=>Ref node). 

• D3PLOT can also output current coordinates (using WRITE, XY_DATA) in 
the local coordinate system. This option is switched on in the Deform=>Ref 
node menu. 

Deform – Shift Def & Ref node   
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Deform – Shift Def Coordinate System  

• The three nodes selected for Shift Deformed, and the local 
coordinate system, may now be displayed. 
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Display options 

• Display Options controls the appearance of each plot 
and many of the items drawn on each plot. 
 
Element Switches 
• These options control the display of back and internal 

faces of 3D elements and the display of element triads 
showing the local element axes. 
 

Element Appearance 
• These options control how a number of different element 

types are drawn. Some types have alternate symbols 
while others have options to control their sizes. 
 

Display Switches 
• These options can be used to display a box around the 

model and to display a models undeformed geometry. 
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Display options : Window Dressing 

• Window Dressing controls which additional items are 
added to plots. 

 
 

Header 

 
 

Header 

Border 

Triad 

Clock 

Contour Bar 
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Display Options : Graticule 

• The Graticule Option can be used to display the 
current model dimensions. 

• In 2D mode the graticule shows either model space 
or screen space depending on the view 
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Display Options : Graticule 

• In 3D mode the size and location of each plane can be 
set along with the grid spacing along each axis. 
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Display Options : Fonts 

• Set text font size for 
– Labels 
– Title 
– Clock 
– Contour Bar 
– Graticule 



LS-DYNA ENVIRONMENT 

[back to contents] 

Display options: Element overlay 

No Overlay 

All edges 
 

Feature Edge 
 

• The Overlay Options control how the hidden line 
overlay is drawn along with the colour used for the 
overlay (shortcut ‘Y’ cycles no/free/all overlay) 
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Multiple Models / Windows 

• D3PLOT can accept up to 32 models simultaneously, subject to memory 
limit on your computer. 

• To open a new model use the “File” menu. 
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Multiple Models / Windows 

• By default, D3PLOT opens a new window for each new model. This 
can be changed here when opening each model 
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Multiple Models / Windows 

• In addition to multiple models D3PLOT can 
have up to 32 windows simultaneously.  

• If you have loaded multiple models, any 
combination of Models M1, M2… in each 
window W1, W2, etc is permitted.  
 
 

• If you have multiple models then when you 
open a new window, D3PLOT asks which 
models should be put into it. 
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Multiple Models / Windows 

• The Edit Window menu allows 
the Model/Window combination 
to be changed 

• This menu offers colour by 
model to help identify models 
when overlaid 
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Multiple Models / Windows 

• The Edit Window menu also allows 
spatial offset between models 
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Image and movie output 

Bitmap, jpeg 
images 

Press Capture 
to record. 

Movie files. 
Press Capture 

to record. 

Images and movies can include 
any or all of the windows, 

including the T/HIS window if 
active. 
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Image and movie output 

Postscript – includes 
multiple images on one 

page 
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Shortcuts - customising 

• Shortcuts are customisable and can be saved 
to different keys. 
 
 

• Set the keys in the shortcuts menu accessed 
through Options (see menu on next slide). 
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Shortcuts - customising 

Javascripts and 
Command Files can 
be assigned to keys 

Note: Capitals and 
lower case can be 

different 

Save setup in 
home oa_pref file 

These functions can 
be set from the pop-

up menu 
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Documentation - What’s new? 

• A PDF document describing the latest features can be accessed from within 
D3PLOT at any time: 
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Advanced Options 
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Find Attached 

• The Attached menu can be used to find entities that are 
physically attached together. Each time you press 
Attached, D3PLOT does the following: 

• Looks at what you want to find attached (beams, shells etc.), 
• Find what is immediately "attached to" what is currently 

visible, 
• Unblanks these newly found items 
• Redraws the image. 

 
• The result is progressively more and more of the model 

being drawn until nothing attached to what is currently 
visible (which is not necessarily the whole model) remains 
to be unblanked and drawn. 

 
NOTE: This is slightly simpler than the Attached function in  
Primer as it only finds items attached at nodes. 
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Find Attached 

Attached function unblanks 
entities attached to those 

already visible. 
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Find Attached 

Attached can unblank whole 
attached parts instead of 

element-by-element 
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• Finding which elements have a particular contour level:  

Hover over a contour colour. 
The mouse symbol changes to 

CONT OPTS. Left-click to 
display only those elements 

which have that contour level, 
or right-click to see more 

options: 

Contour options 
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• Finding which elements have a particular contour level:  

These options use the 
existing “Limiting Values” 

capability; this menu appears 
automatically when you click 

on a contour bar. 
Result of left-click on 
contour bar: only the 

elements with that contour 
level are displayed. 

Contour options 
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To see these elements in 
context, draw the other 

elements in Outline 

Contour options 
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Groups 

• D3PLOT allows the creation of groups, 
which then can be used in a number of 
menus, including: 
– Quick-pick 
– Blanking 
– Write 
– XY-Data 
– Part tree 
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Groups 

• Groups can be added to the Part 
Tree 
– Blanking and visual attributes can 

be set from here by right-clicking on 
the group 
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Groups 

• The visual properties of groups can be written to and read from the 
groups ascii file, e.g. 

*GROUP 
$ Title 

TORSO 
$ Label     Colour       Transparency   Display Mode   Overlay Mode   Overlay Colour   Brightness   Shininess   Blanking 

Status 
         1        RED          50                       CURRENT      CURRENT        *                         90                 70             UNBLANKED 

$ 
PART                        1 :          3 

$ 
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Tuning Graphics Performance 

• D3PLOT can be tuned to take advantage of the 
capabilities of new graphics cards – typically for 
hardware manufactured from about 2007 onwards. 

• Speed of animation of large models can be 
increased up to 5x or more on some graphics cards 

• Instructions for doing this are given in the “Explain 
this” button. 

• After tuning the performance, the settings can be 
saved to the preference file. 
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• Open multiple models simultaneously, by browsing for a directory. Any LS-
DYNA plot files in that directory or in subdirectories will be found and 
displayed. 

1 
2  

3 

4 

5 1. Select the directory option 
2. Browse for directory 
3. Select models 
4. Decide whether each model 

should have a separate 
window 

5. Press “Open Models” 

Open models from directory 
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Opening Models – Model Database 

• Multiple models can be selected from a model database. 
 

 
 

1. Select the database 
option 

2. Browse for the 
database file 
 

1 

2  

• The same database of models is used for D3PLOT and T/HIS. 
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Opening Models – Model Database 

• After selecting the database a new window will 
be displayed showing the contents of the 
database. 

• As models are selected they are highlighted. 
M1, M2, etc indicates the D3PLOT model 
number after reading in. 

• Models that cannot be found are marked with 
a  red cross. 

• Entries can be modified and deleted by right-
clicking on them. 

• New models can be added to the database 
interactively and the database saved for future 
use. 

• The database file is XML based and can easily 
be edited by hand. 
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Opening Models – Template File 

• An optional “Template” file can be specified when opening models:  
 
 
 
 
 
 
 
 
 
 
 

 
• The “Template” file controls which window each model is loaded into. 
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Opening Models – Template File 

• All of the options available in the 
“EDIT Window” menu can be 
defined in the template file. 

• The template file can contain 
settings for undefined models that 
are automatically applied after a 
model is opened. 
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Control of settings and properties 

• Some functions operate on a per-window 
basis. For example, cut sections may be 
applied to one or more or all windows; 
similarly for contour components, contour 
levels, etc.  

• These menus have Window Tabs to show 
which windows should be affected when you 
work in that menu. Click the tabs to 
activate/deactivate. 
 
 
 
 
 
 

• Can also deactivate a window by clicking 
here: 

Changes affect all 
3 windows 

Changes affect 
only W1 
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• Colour, transparency and blanking are stored 
per Model, not per Window. Similarly, output 
from WRITE and XY_DATA is for a specific 
model. In these menus the tabs show M1, M2 
etc instead of W1, W2. These control which 
model is being worked on. 

• The Settings (non-model-specific, such as 
window layout, background colour, view, etc) 
may be saved to a settings file (e.g. 
d3plot001.set). The model-specific properties 
(blanking etc) may be saved to a Properties file 
(modelname001.prp). Both these files may be 
written or read back in from the File menu. 

• Settings/properties files are automatically read 
in if the same model is read into another 
session of D3PLOT 

Control of settings and properties 
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Settings files 
• A “Settings” file can be saved containing all the model-

independent parameters of all the windows in a D3PLOT session.  
• The settings file also includes layout and contents of any graph 

windows. FAST-TCF scripts are included in the settings file so 
that the same curves may be re-created using different model 
data. 

• It can be used to restore all your settings, views and graphs in a 
future D3PLOT session.  

 
  

 

This option is useful when the settings file 
references multiple models – the user can 

browse separately for Model 1, Model 2, etc.  

Option to read settings file when opening a 
model 

Save/retrieve settings 
file from Utilities menu 

Back to Contents 
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Settings files 
• A “Settings” file can be saved containing all the model-

independent parameters of all the windows in a D3PLOT session.  
• The settings file also includes layout and contents of any graph 

windows. FAST-TCF scripts are included in the settings file so 
that the same curves may be re-created using different model 
data. 

• It can be used to restore all your settings, views and graphs in a 
future D3PLOT session.  

 
  

 

This option is useful when the settings file 
references multiple models – the user can 

browse separately for Model 1, Model 2, etc.  

Option to read settings file when opening a model 

Save/retrieve settings 
file from Utilities menu 

Back to Contents 
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Settings files 

Save a settings 
file  

Read in the  
settings file 

Open a different 
model in a new 

session of D3PLOT  

The windows will have the same 
settings and layout; equivalent 

curves will be created 
automatically 

Back to Contents 
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1. Set up blanking, 
colours, etc in one model.  

2. Right-click on the model 
in the Part Tree, use 

Export.  

In this example, 4 similar models have 
been read into 4 separate windows.  

Exporting properties between models 
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Note that the view is a property of a window, not of a 
model, therefore it cannot be exported from the Part Tree. 

To make the views the same across all windows right-click 
on square in top-left corner, “Export view”  

A new alternative is to use shortcut 0 (zero key), when the 
mouse is in the window that has the “correct” view. 

Exporting properties between models 
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Exporting properties between models 
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Overlay & comparison of models 

Now we wish to 
compare a similar 
model in the same 
window. 

Select window(s) to 
display the new model: 
“Next” means open a 
new window, “W1” etc 
are existing windows 
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Overlay & comparison of models 

If two or more models are 
superimposed on one 
another, it is difficult to 
differentiate and compare. 
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Overlay & comparison of models 

The models can be 
distinguished by colour-
coding each model and 
the differences can be 
viewed, e.g. in a cut 
section plot. 
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Overlay & comparison of models 

“Screen space” will offset the models in the coordinate system shown in red 

x 

y 
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Overlay & comparison of models 

Differences in results between similar models can be hard to see…  
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Overlay & comparison of models 

“Use Current” means: plot the difference 
in the output variable relative to the 
current time state of the reference model 
(shown on the left). In other words, the 
reference state is the one shown in the 
picture, and will be updated during 
animation. As seen the reference model 
results relative to itself is zero. 
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Reflecting Models and Results 

• Deform=>Transform applies a geometrical 
transformation to the model geometry and results. 

• A typical application would be to change a right-half 
model into a left-half model. 

• The transformation does not change a half-model into a 
full model  – you get just the reflected half. 
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Reflecting Models and Results 

• To see both halves together, read the original model 
again into the same window (this will become Model 2).  

Reflected 
instance of 

original model 
(Model 1) 

Second instance 
of original model 

(Model 2) 
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Reflecting Models and Results 

• Results are also transformed, so the pair of models can 
be animated and results plotted as if it were a single full 
model. 

Reflected 
instance of 

original model 
(Model 1) 

Second instance 
of original model 

(Model 2) 
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Faster animation 

• The COARSEN feature can be used to 
speed up the animation. This works on 
models containing large numbers of 
quadrilateral shell elements by reducing 
mesh resolution in areas where the 
mesh is relatively flat.  
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Faster animation - Coarsen 

No coarsening   
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Faster animation - Coarsen 

Mild coarsening – typical 30% 
speed-up, can be 2-3 times faster 
for multi-million element models.   
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Faster animation - Coarsen 

No coarsening   Severe coarsening – typical 50% 
speed-up, can be 4-5 times faster 
for multi-million element models.   
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D3PLOT-T/HIS link 

• Click on the T/HIS tab to start T/HIS 
inside D3PLOT 

• Full T/HIS menu system available – 
switch between D3PLOT and T/HIS 
menus using the tabs  

• Supports multiple models, T/HIS 
automatically opens all models; 
results from either or both models 
are continuously available. Here, the 
entity display type is set to “Common 
Ids”, allowing comparison of results 
for the same node across the two 
models. 
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D3PLOT-T/HIS link 

• When picking entities in T/HIS, a Pick 
Visible option is available, allowing 
entities to be picked from the D3PLOT 
windows 

• Visibility of time-history data entities, and 
labels of these, are turned on/off in 
D3PLOT’s Entity menu 
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When this box is checked, 
the Timeline is drawn at 
the time of the current 
state in D3PLOT. When 
animating, it moves to 

synchronise with D3PLOT 

Click on the graph to position the 
timeline and change D3PLOT to the 

nearest time-state. 

D3PLOT-T/HIS link 
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Right-click on a curve, press 
LOCATE – a cross-hair identifies the 

entity used to create that curve 

D3PLOT-T/HIS link 
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When running T/HIS linked with 
D3PLOT, spotwelds can be 
selected by “Pick Visible” to make 
a graph of the spotweld forces. 

1 

2 

3 

D3PLOT-T/HIS link 



LS-DYNA ENVIRONMENT 
Slide 
144 

 

The “Locate” function in T/HIS shows 
which spotweld’s forces are shown in 
each graph (colour of graph matches 
the colour in the cross in the picture). 

D3PLOT-T/HIS link 
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ALE data components 

LS-DYNA outputs a number of specific ALE data components that can be plotted in 
D3PLOT 
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ALE data components 

Fluid Density 
This show the density of the fluid in each element which can vary during an 
analysis 

Air (ρ=1.23kg/m3) 

Water (ρ=998kg/m3) 
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ALE data components 

ALE Volume Fraction: 
One option allows you to show all the fluids (1 = Fluid 1, 2 = Fluid 2 etc) or you can 
show the volume fraction for each fluid in your model. 

Dominant ALE Fraction  ALE Fluid 1  

100% Fluid 1 = 
1.0 

100% Fluid 2 = 2.0 
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ALE data components 

ALE Mass Fraction: 
This allows you to show mass fraction for each fluid in your model. 
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Visualizing ALE results 

The ISO contour plot method in D3PLOT can be used with the volume fraction data 
component to visualize the interface between two fluids.  

ISO option 

Contour 
Controls 

Click to 
change 
colour 
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Visualizing ALE results 

An ISO plot is also useful for visualizing the pressure wave in a blast analysis.  

The max/min contour levels may need to be set manually to achieve a good image.  

Contour 
Controls 
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Trace Node 

• The trajectory of selected nodes can be drawn  

Select 
nodes 
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Trace Node 

• The trajectory of selected nodes can be drawn  

Options to 
change the 
appearance 

of the trace – 
thickness, 

colour, fade, 
symbols. 
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Trace Node – save to curve file 

• The trajectories of selected nodes can be XY 
plotted and transferred to T/HIS 

Transfer to T/HIS link Save as curve files 

Back to Contents 
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Trace Node 

• Trace Node can also be applied to airbag particles or to SPH 
elements. 

• Multiple items can be selected in one operation. 
• Traces can also be selected through the Quick Pick menu 
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XY_DATA 

• Using the XY_Data Composite option, certain 
combination of data can be extracted, for example, 
shell thickness versus x-coordinate on the symmetry-
plane at a number of time-states.  
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XY_DATA 

• Screen-pick a line of elements (or nodes), e.g. by 
dragging out an area:  
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Select data 
component for 
X and Y-axes   

Select time states (*) 

(*) - in previous 
versions of D3PLOT, 
this could be done only 
from the main 
XY_DATA menu   

Curve file name (*)   

The order of elements picked 
is random (not in order of x-
coordinate), so the graph 
appears wrong    

XY_DATA 
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Function to sort 
points, e.g. by x-
value (so the points 
appear left-to-right 
on the graph). Press 
Resort. 

After re-sorting, the graph is 
correct    

XY_DATA Composite plot: each curve represents 
one time-state; each point on the curve represents 

one entity (node, element, etc); the user selects 
the data component for both X and Y-axes. 

XY_DATA 



LS-DYNA ENVIRONMENT 

[back to contents] 

Curves can be processed further in T/HIS – either 
write curves files & read into separate session of 

T/HIS, or start the T/HIS link before using 
XY_DATA and press => T/HIS 

XY_DATA 
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Another example of Composite data – X-coord vs Y-coord 
shows how the shape evolves with time 

XY_DATA 
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Data-vs-Data is almost identical to Composite, except that a new curve is written for each 
selected Entity (node, element, etc), with each point on a curve representing one time state. 

XY_DATA 
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XY_DATA 

Examples of 
Data-vs-data 

Trajectory of a node 
(x-coord vs y-coord)  

stress-vs-strain for an element 
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XY_DATA - Output of Measure 

The measurements created by  
“Measure” can be output to T/HIS: 
 The XY_DATA graph 

menu can start a 
linked T/HIS session: 
the “=> T/HIS” button 
is always live. 
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External Data – “Blob plots” 

• A list of points, each with XYZ 
coordinates and a data value, can be 
read from an external file 

data 899.984 1393.17 895.182 4682.63 
data 841.037 1276.24 896.854 1055.947 
data 694.404 1399.28 851.726 343.4052 
data 703.138 1308.79 861.869 627.7126 
data 804.945 1171.9  898.937 476.1642 
data 788.008 1057.62 903.647 467.8154 
...(etc)... 

Contents of typical file:  

“data”    X               Y              Z              value   
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• The data 
points are 
displayed as 
“blobs” 

Settings for blob style, 
size and contour levels   

Browse for file, press 
Read File, then SH to 

redraw with “blobs”   

External Data – “Blob plots” 
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• Lines can be 
included in the 
external data 
file if required 

External Data – “Blob plots” 
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Text font size and type 

• Set text font size for 
– Labels 
– Title 
– Clock 
– Contour Bar 
– Graticule 
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Compressed (cut-down) PTF File 

• Cut-down PTF / d3plot files can be generated 
containing a subset of the data in the original files 
 

Back to Contents 

• Reduction in the size 
of files is possible by: 

– Reducing the 
number of  PARTS 

– Reducing the 
number of STATES 

– Removing data 
components 
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Compressed (cut-down) PTF File 

• File family member file size can be set 
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Compressed (cut-down) PTF File 

Original model Cut-down model 

4 PTF Files, 93 MB 
158 parts 
32 time-states  
Displacements, velocities, 
Accelerations, stresses, shell 
resultants 

1 PTF File, 5 MB 
98 parts (dummy only) 
20 time-states 
Displacements only 

 
 

Back to Contents 
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New File Format for Quicker Response 

Batch mode operation: 
• First time – select the data 

interactively, record this file 
• Next time – run D3PLOT in batch 

with –ptfcut=filename.txt 

Select the new re-
ordered file format 
for faster 
animation of 
stress and strain 
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New File Format for Quicker Response 

D3PLOT 
Animate 
stress or 

strain 

Slow 
Reading stress or strain 
data is slow because of 

the structure of LS-
DYNA’s d3plot file 

D3plot file 
This process can be 

done interactively or in 
batch. 

LS-DYNA submission 
function could be 
modified to do this 

automatically when LS-
DYNA terminates 

The new file format is 
called “reordered” 

LS-DYNA 

D3plot file 

New file 

D3PLOT 
Animate 
stress or 

strain 
Reading data is 4-8x faster 

LS-DYNA 

D3PLOT 
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File Format for Batch Mode 
The file that can be used to create a reordered database in batch mode is a command 
file with  the following format. It can be created manually, or recorded from the 
“Compressed PTF” menu . 

*TEXT_ONLY 
/UTILITIES PTF_COMPRESS 
$ 
OUTPUT_TYPE 
REORDERED 
$ 
FILENAME  
C:\Models\sled\d3plot_cutdown001.ptf 
$ 
PART 
ALL 
$ 
STATES 
1 TO 9 
$ 
FAMILY_SIZE  
1444 
$ 
ALL_OFF 
VELOCITIES 
PLASTIC 
SHELL_THICKNESS 
SHELL_VM_STRESS 
SPC 
SPRING 
SEATBELT 
$ 
NODES_FOR_ZTF 
$ 
EMBED_ZTF 
$ 
APPLY 

 

Select the PTF_COMPRESS menu 
Set the output type to ‘REORDERED’ 
Specify the output filename 

Select the parts to output 

Select the states to output 

Set the family size in KB 

Select the data components to output 

Include nodes for ZTF items  
Embed the ZTF file in the file 
Write the Reordered database 
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• All Oasys programs can read an image file, for use as 
background 
 

 

Background Image 



LS-DYNA ENVIRONMENT 

[back to contents] 

Background Image 

• An image file (e.g. jpg, png, etc) may now be 
read into D3PLOT for use as background. This 
can be useful for setting up the position of a 
dummy or other components to match photos 
from a test. 

Browse for 
image file 

These options maintain the original 
aspect ratio (important if using “adjust 

view to image”) 
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Background Image : view matching 

Pick a node in the model, then click on 
the equivalent point in the background 
image. Repeat to create several node-
point pairs – we recommend at least 5 
pairs.  Choose some pairs close to the 

camera, and others further away, to 
capture the depth of the image. 
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Background Image : view matching 

Press “calculate view” – model 
viewing angle and perspective 

changes to minimise screen distance 
between picked nodes and their 
equivalent points in the image.  
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Background Image : Target and Eye 

• Define camera (“eye”) and target locations 
• D3PLOT calculates view angle and 

perspective automatically 
• Saves time when comparing to test photos 

Pick EYE node 
Pick TARGET node 

Locations can be input as: 
1. x,y,z coordinates 
2. Current view “{C}” 
3. Pick node Assign an “up” vector (e.g. global Z) 

or let Primer do it automatically 

Perspective distance 
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Background Image : Target and Eye 

Multiple views 
can be stored  
in separate file 

“plot.view” 
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Background Image : Target and Eye 

• Can be used to 
help line up the 
model with a 
background 
image or movie 
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 e.g. Movie at 0.002s per frame vs. 
Simulation at 0.005s per frame. 

 
  To match, we need every 5 frames 

of the movie and every 2 frames of 
the simulation. 

• Animation files may be read into a D3PLOT window (same window as 
model, or different window).  

• Align model view to movie in the same way as  
 image 
• Use Movie Options to synchronise  
 view and timing with model 

Background Animation 
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• User-defined data 
components for contour 
plots 

• Example – displacement 
in a local axis system 

• The local Z displacement 
will be calculated by a 
formula from the global X 
and Z displacements. 

Name of 
component 

In this example, 
we calculate a 
single value for 

each node 

The method used is a simple 
formula, using maths operations, 

numbers and existing data 
components. Here, DX means x-

displacement, DZ means z-
displacement 

Explanation & data 
components listed here 

User-defined data 
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• Having defined the data component, we can now 
select it in the Data menu.  

User-defined data 
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• Another example – failure criteria, in this case for beam-element spotwelds. We 
have calculated a failure criterion using a formula based on the beam force 
resultants.  

• The formula can include mathematical operations such as SQRT or ** 

User-defined data 
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• Components that were simple formulae or read from file can be saved as 
.ucf files. 

• The user-defined data components will then be available automatically in 
subsequent sessions of D3PLOT. 

User-defined data 
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D3PLOT JavaScript 

• JavaScript is a fully-featured programming language, widely used for web 
programming, and similar to C++, C, Perl, etc. 

• Allows users to program their own functions for D3PLOT, by writing a script 
(program) that the JavaScript interpreter understands. 

• JavaScript Interpreter has been embedded in Oasys PRIMER, D3PLOT, 
T/HIS and Reporter. No special software or system setup is required.  

• JavaScript has “Core” (standard) capabilities described in textbooks, e.g. 
– variables, arrays, strings, objects, functions, regular expressions. 
– Statements if, do, for, while, switch etc. 
– Operators + - / * ++ -- && || etc (like C and Perl) 

• The Oasys software development team have extended JavaScript by 
adding new functions to access D3PLOT’s data and store new results ready 
for plotting. Users’ scripts can include both Core functions and Oasys 
extensions. 

• The compilation step is done inside the interpreter – the script is source 
code and works on any computer platform.  
 

Back to Contents 
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How to run an existing JavaScript 

1. Tools=>JavaScript 

2. Browse for the 
script 

3. Run 

• Each script is a separate text file. 
Scripts can be in any directory.  
 

Back to Contents 
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Plotting data created by a JavaScript 

• If a JavaScript has been programmed to 
create results data for plotting, these will be 
stored as User-defined Binary (UBIN) Data 
Components 

• The new data components will appear under 
User in the Data Component menu. 

• Nodal data components will be under Nodal 
Results=>User, Solid or shell data will be 
under Solids and shells=>User, etc 

• The data is also stored automatically on disk 
in files named jobname_1.ubd, 
jobname_2.ubd, etc. Next time the model is 
read into D3PLOT, the same data 
components will be present because D3PLOT 
will read them from the *.ubd files. 

Back to Contents 
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Making your scripts available to others 

• Any script can be run by browsing for 
the script file. 

• To make a script available more easily, 
copy it into the directory 
$OASYS\d3plot_library\scripts. For each 
script in this directory, a button appears 
in the script menu. Pressing the button 
runs the script. 

• The same system applies in PRIMER 
 

By default, the script file 
name appears on the button 

Back to Contents 
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Making your scripts available to others 

// name: Damping 1 
 
// description: Calculate damping data from modal analysis 
 
// It is assumed that Model 1 is the d3eigv file 
 
// The script writes out damping data per mode 
 

To change the name of the button (and 
optionally 
to add hover text for the button) add a special 
comment at the top of the file containing text: 
 
name:<name for button> 
description:<hover text to display> 
 
 

Back to Contents 
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D3PLOT Scripting 

• Advantages of writing a JavaScript to create a new capability: 
– Quick turnaround – don’t have to wait for new version of D3PLOT 
– Can keep your application confidential 
– Under your control – can do it yourself if you wish. 

• Possible applications 
– Read data from an external file and plot it, e.g. spotweld forces from the swforc 

file 
– Calculate and plot failure-related data, e.g. stress/yield stress 
– Complex calculations involving comparisons of results across time-states  

• Resources for programmers 
– Training material is available to download at http://www.oasys-

software.com/dyna/en/training/tutorials.shtml .  
– Core JavaScript functions are described in textbooks, e.g. “JavaScript – The 

Definitive Guide” (5th edition) by David Flanagan, published by O’Reilly. ISBN 0-
596-10199-6  

– Also try Web search for “core JavaScript reference” 
– D3PLOT’s JavaScript extension functions are described in Appendix VI of the 

D3plot manual 
– Example scripts are provided in the $OASYS/d3plot_library/examples and 

$OASYS/d3plot_library/scripts directories 
 

 

Back to Contents 

http://www.oasys-software.com/dyna/en/training/tutorials.shtml
http://www.oasys-software.com/dyna/en/training/tutorials.shtml
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JavaScript v User-defined data? 

• User-defined data components can be defined directly in D3PLOT, e.g. 
using “simple formula” method. This is easier than writing a JavaScript to 
calculate results. When is a JavaScript needed? 
– “Simple formula” can be applied when the user-defined result for node n 

at time t depends only on data that exists in the ptf/d3plot file (e.g. 
displacements, velocities) for node n at time t. Similarly for elements – if 
the user-defined data at time t depends only on existing data for that 
element at time t. 

– If the user-defined data requires knowledge of results across multiple 
nodes/elements, or across multiple time-states, then “simple formula” 
cannot be used and a JavaScript is needed. 

– If the user-defined data is calculated using branching logic (i.e. is not a 
one-line mathematical formula), a JavaScript is needed. 

– If the user-defined data is calculated using data from an external file, in 
combination with the data in the results file, a JavaScript is needed. 

Back to Contents 



LS-DYNA ENVIRONMENT 

[back to contents] 

Page Control 

• D3PLOT allows windows to be arranged on multiple pages. One page is 
visible at any time.  
 

• Pages can be viewed using the 
controls at the top of the screen 

• The Page Up and Page Down 
keys can also be used to scroll 

through the pages 
 

Back to Contents 
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Page Layouts 

• Windows are displayed on ‘pages’ 
• The layout and number of windows per page is controlled in the layout 

panel 
 • Defined layouts can be selected to 

automatically set the page layout 

• Manual page layouts can be defined using 
the ‘Advanced…’ button 

• Windows can be placed on different pages 

Back to Contents 
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Menu Attributes 

• New Menus function offers left-
handed settings, font size and 
display factor 

• These are also available as 
preferences, under 
“menu_attributes”.  

• Interactive setting of display factor 
helps with wide screens, when the 
same preference may not suit all 
users. 
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Menu Attributes - Dynamic Viewing 

• Customisable dynamic viewing (i.e. control 
over which mouse buttons and keyboard 
keys are used to rotate, zoom and pan) 
can help users who are familiar with the 
dynamic viewing controls of other pre- and 
post-processors. 
 

• Dynamic viewing behaviour may be set 
using the Options=>Menu Attributes 
menu. 
 

• The settings may then be saved to the 
Preference file for use in future D3PLOT 
sessions. 

Settings that mimic 
the dynamic viewing 

control of other 
commercial pre- and 
post-processors… 

....or, use drop-down 
menus to change the 

action for each 
combination (mouse 

button + meta key), e.g 
left-mouse+shift = zoom 
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Edit Preferences  

• Users can change their preferences (customisable settings) from within 
D3PLOT. 

• Remember to 
Save 
Preferences 
before 
dismissing the 
menu. 
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Shortcuts 

• Shortcut keys: buttons on keyboard that access commonly used 
functions. Not case sensitive.  

– ? = list of available shortcut keys 
– ESC = dismiss the menu that the mouse is over  
– 1,2,3,4,5,6,7,8 = XY, XZ, etc standard views; V = View menu 
– A = Autoscale 
– B = blanking menu; R = reverse all blanking; U = unblank all 
– E = entity visibility menu 
– H, L, S and F = perform Hidden line, Line, Shaded and Fringe (SI) plots 
– M = measure node-to-node 
– O = Display Options panel; P = Properties panel 
– Q = Return to Quick-pick mode 
– X = Cut Sections menu; D = Drag cut section; N = pick node on cut section 
– Z = zoom (drag across rectangular area) 
– + and – = zoom in and out 
– I = Iconise all menus; T = tidy all menus; C = close all menus 
– Arrow keys ← , → : back/forward one state; Home = first state; End = last state 
– Space Bar – start/stop animating 
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Contact Information 

UK: 
Arup 
The Arup Campus 

Blythe Valley Park 

Solihull, West Midlands 

B90 8AE 

UK 

T +44 (0)121 213 3399 

F +44 (0)121 213 3302 

dyna.support@arup.com 

For more information please contact the following: 

www.arup.com/dyna 

China: 
Arup 
39/F-41/F Huai Hai Plaza 

Huai Hai Road (M) 

Shanghai 

China 200031 

 

T +86 21 6126 2875 

F +86 21 6126 2882 

china.support@arup.com 

India: 
nHance Engineering Solutions Pvt. Ltd (Arup) 
Plot No. 39, Ananth Info Park 

Opposite Oracle Campus 

HiTec City-Phase II 

Madhapur 

Hyderabad - 500081 

India  

T +91 (0) 40 44369797 / 8  

india.support@arup.com 

or contact your local Oasys distributor 
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